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About PDF to Flash Page Flip Pro

PDF to Flash Page Flip Pro is a highly developed flip book program
that can create awesome publication with vivid flipping pages from
simple PDF. It can help you add almost any media to your book
including YOUTUBE video, SWF flash or pictures etc. And it can also
support command line so that you can complete the conversion

without wasting precious time.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping eBooks.

PDF to Flash Page Flip Pro is a highly developed flip book program
that can create awesome publication with vivid flipping pages from
simple PDF. It can help you add almost any media to your book
including YOUTUBE video, SWF flash or pictures etc. And it can also

support command line so that you can complete the conversion
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without wasting precious time.

Powerful editing features:

1.

Insert link and define its action type (go to page, photo slideshow,

called JavaScript action);

. Insert new button icon calling new action if necessary;

. Utilize about button to add your contact or some other information;

Insert image to the page you imported (customize its action, like play
audio, go to webpage ,etc);

Insert FLV movie and define every detail of the movie;
Insert fitted sound to your page;

Insert SWF flash to enrich your page;

YOUTUBE video can be added to your page;

Output project embed links, video and sounds, save it for future

using.

Import Features:

1.

2.

Import all pages or the pages you wish;

Set a exclusive watermark which is only belong to yourself;

. Define the page quality, whether high or other;

Import the bookmark from original files;

. Preserve the hyperlink including web link, page link and email link of

the original PDF files in page flipping book;
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6. Enable function of search if needed,;

7. Detect wide page so that it can be viewed clearly and comfortably.

Customized Color Schemes Features:
1. Define button color, search highlight color, icon color;
2. Set font color, whether window font, book mark font, window font

or search result font;
3. Design background color, flash window color and page background
color;

1. Turn any PDF file Cincluding its bookmark, links) to adobe flash
based page flipping book;

2. Support converting PDF files in batch to page flipping book;

3. Replace the existing icon with new button;

4. Utilize about button to add your contact or some other information;

5. Use command line to finish the conversion automatically;

6. Choose a built-in theme or template (classical, float, neat, spread) as
you like;

7. Add your own book title or book logo to the page flipping book
button bar;

8. Define content of help window, also the looks and feels;

9. Select a built-in theme or template (classical, float, neat, spread) as

you like;
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10.Insert a sound file which will be playing as a background book music;

11. Use zoom in/zoom out unlimitedly and set zoom scale;

12. Tell your friends, partners via email or upload it to social network
like Face Book, Twitter, Digg, Google, etc;

13. Support auto-flip with flip-interval and play count setting;

14. Enable single page or double page view mode;

15. Set Multilingual version for different countries ;

16. Add book frame bar to flip much easily;

17. Set book reading from right to left for words start with left
languages;

18. Design hard cover to enhance the feeling of the book;

19. Set a password to prevent others accessing ;

20. Use GOOGLE analytics to learn about your readers and their
behaviors;

21. Know the effect after setting immediately;

22. Export and save the project if you think everything is okay;

Free Publish Features:

1. HTML is a format which gives you the ability to publish your book to
the Internet;

2. ZIP is a format which gives you the ability to you share the book

with your friends ,partners via email;
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3. EXE is single output format which gives you the ability to read
separately;
4. Mobile version is for people to read page flipping book on tablet, I0S
and Android devices;
5. App is an executable software which can run on independently;
6. Burnto CD/DVD lets you copy it easily.
Page Flip Book Features:
1. Drag the corner of the page to go to previous or next page;
2. Click the page arrow or page frame to reach the previous or next
page;
3. Use thumbnail button to navigate fast through a large publication;
4. Just need a few clicks on navigation buttons to go to previous page,
next page, first page and last page;
5. Click help button to get a hand when needed;
6. Use search button to find out the page to get related info;
7. Print out the whole book or some pages only;
8. Make the book full screen for convenient reading
9. Zoom in/ zoom out on pages if the page font is too small to read;
10. Turn on/ off the background music;
11. Flip with a single page or double pages;

12. Share with anyone via email, Face book, Twitter, Digg, Google etc;
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13. Download the ZIP or EXE book from website to read locally
directly;

14. Enjoy this digital publication on Tablet, IOS and Android devices.

Easy Start

1. Launch the application via the desktop shortcut I ;

’

2. Click the "Import PDF" icon 1":' to enter into Import PDF interface;
3. Click L_#®**= |icon to choose PDF file from your computer;

4. Click ImPerthow j;-q, to enter into template setting interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and

then click the "Apply Change" icon ;

L=

-

6. Click "Convert to Flipping Book" icon to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take
a;}’ @ =html
= as example;

8. Click | ®2"*= |{5 set Output Folder as "C:\flipbook", input File Name

as "demo";
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9. At last, click icon to output created page-flipping eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:

s &

files bookswf  demo.html

Open the "demo.html" file to view your created pOOage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

o N> eSO

“.E'_: — PDF to Flash Page Flip

S Tt FIF i elook whb pape M e

Interfaces

There are some main interfaces you will see while using PDF to Flash
Flipping Book Pro as below shows: Application Options, Import PDF,
Template Settings, Edit Pages, Language Option, Export Theme, Output,

Batch Convert and Command Line.
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You can enter into each page to get clear instructions for every detail

option.

I. Application Options Interface
1. Render Engine Option

PDF to Flash Flipping Book Provides 3 different render engines for you to create
higher quality page-flipping eBooks, click "Options->Application Options" to enter
into "Render Engine" interface:

Feamder Engane
Fiease seleche a render engine for the conversion
kbl

E'."."F
"

L Ghestsript Dowdoad Ghosteript

@ frner Library

SWF: Much legible characters, smaler output size
L Ghostsoript: Higher color ransfer quality

Inner Library: Faster convert speed

| ok Canesd

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when PDF imported failed)

2. Create Mobile Version Option
(1) Pages Quality and Size

Five types of "Pages Quality And Size" for mobile version eBooks:
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Pages Quality and Size

Quality And Size:

High quality large file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

4, Highvaluesp
= butreguirem

(2) Mobile Template

The current version provides two mobile template modes for you to use: Slide and
Single Page Flip. The later one adds page-flipping effect on the pages while viewing
in mobiles.

Il. Import PDF Interface

|&] import PDF (o]

Source PDF Flie

Browse., l I Openit |

The Page Ranges to Import Watermark

2 all pages AT E Place a custom text or image

(@) Custom range: 1-10 Example: 1,3,5,9-21 f 3? Watermark(Stamp) to the file(s)

[¥] Quickly import {Only import 10 pages to initial preview) Set Watermark
Page Quality

Quality And Size: [High quality large file size VI

M High values produce better page quality but require mare disk space and more time to download.

[ 1mpart bookmark [] mpart links [¥]Enable search

Import How Cancel |

Panel Description:

1. Source PDF File:

Click this icon to open the PDF file you want to convert;

Open it View content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

©alpages oo hvert all pages to page-flipping eBook;
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@) Custo 25 E 11,3,5,3-21 .
L xample:1,3;5, Convert defined range page;

(9] Quicidy import (Orly import 10 pages to ritial previen) Just preview effect on first 10 pages.

3. Watermark

Set Watermark Add image or text watermark to flipping pages.

Applying Watermark Check this option first to choose default stamps or add new ones:

) aa e wotermark - “
A Add Text Watermark

Text Name

fame:  Text Watermark

Teak:  Page-fipong ehock Mseres: -

'ﬂlwﬁf -

ont @ pebesce =] 17 Enbeadet pont
Fo | o
Shie: (] Gold [ abe | underine.
Text Layout

Layout: [Fix -] [ A badeground
i Tig Stele 0.07 a7 |
Postion nmargrs  Margrs

w5 Hsenm

Iep: 20

o = ow .

(I
ILE‘ =] Bottom: 20

Text Effect

Onsdty: 0% T mon

Bght 10

Page-fipping eBoak

Rotaton: o T Degee

Edit / -~
Add text stamp fo o

Add image stamp- s ivee waiemae

B Add Image Watermark

Delete Imtge e

Hame:  [mage Waiermark

Move down e e

@]

P ¢ X ¥ &

Move up g i -
Yt %0 % Heght 50

it 1o mergns Ei Stretch 1o marprs E

Image Effect
Dpacity: 0% 1o

Rotaton: 9 % degree ] s background

Postoninmargns  Margns
ol [Hlose %

= = u

=3 fottom: 20
oy
| Mlmeers

M|

4. Page Quality
There are five types of "Quality And Size":

Medium guality medium file size
Low guality small file size
Lower guality smaller file size

5. Other Options:
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[¥] tmport bookmark

If your PDF file contains bookmarks, check this option to use in output
page-flipping eBook;
[¥] Import links . . . T .

If your PDF file has links, check this to enable in flipbook;

(V] Enable search Check this option to enable search functionality in created flipbook.

[/iDetect wide pages o this option to make landscape page in PDF file to be presented as

two-page spread in output flipbook.

At last, click icon to enter into template setting interface.

lll. Template Settings Interface

g coovert

& PDF to Flash Page Flip

= Personalized Settings = Enable/Disable Control Options

Set different backgrounds. Set Book Title and Enable Title Link
Use corresponding bar calors Enable Home Button and Link
Define title, bar font types Show Help Details in JPG or SWF
Adjust page margins, shadows Enable Print Pages or not

Right to left, hard cover Enable Download PDF, ZIP, EXE,

or other

PDF to Flash Flipping Book Professional provides 4 different templates in the program:
Classical, Float, Neat and Spread. Each template contains some unique settings, the below
instructions will show you details about the default three templates.

The design setting interface contains below main parts:
Choose Template, Tool Bars Settings, Flash Display Settings and Flash Control Settings.

1. Choose Template

Templates
‘ ECIassical H

Please customise the flash template here
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Click ‘

E Classical

q
L icon to select templates from below interface:

Fa e g
1] Select a Template —iplE]
; Choose a flipbook template here. (Double-dick to make & quick selection)
. {Mare and more templates will be provided in future. )
Z Get More Themes Online
Newly developed Neat Template provides a stylish and fresh look for you to design more stunning page-flipping eBooks. In Meat
Template, you can add brand logo in the top toolbar, set different featured buttons, show or hide transparent thumbnails at bottom,
enable Social Share via different channels, etc. Neat presentation interface, neat control panels and neat reading manner help to build
your neat feeling publications.
Templates iz
B Classical
[l [IE| Float = L
El Neat
! O -]
[o® spread et
E Calendar Black Pattern Blank Light Shadow
D Condseness
D Lively o 8 o
W ]
: e e | —-—
T singleside @ - e
—n— ] =
Official Blug Offical Red Romantic Pink
I [ Refresh ‘ I Remave The Template | { Remove The Theme | Remove functions needs Addministrator rights!
= = = ="

Download more themes from Flash-Flipping-Book now:

http://www.flash-page-flip-maker.com//templates-themes/index.html .

H Click this icon is to save current settings as a TXT file for later uses;

K a)
% Click this icon is to import stored setting file at once.

2. Tool Bar Settings

iEl Tool Bar Settings
e b

HButton Icons

BeuttonsBar |
_ToolBarontep )
_AddIcons Settings |

|False

(1) Title Bar (only in Float template)

_EITitle Bar

__TheBooklogo
LlogoURL

. Book Titl

Page Mumber Box On .. .|False

| FLIPBUILDER.COM |

_[Co\sers\admini,.,
| http:/ffipbuilder, ..

| <a href=http:/{...
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Customize book title and logo for showing on the top of your flipbook. You are enabled to
set the book title as HTML format text. For example: <a
href="http://www.flash-page-flip-maker.com/'
target='_blank'>FLASH-PAGE-FLIP-MAKER.COM/</a> | <font color="#ff0000' size='14'>Red
Color</font>

(2) Buttons Bar

‘ElButtons Bar

FHHome Button

HAbout Button I
Full Screen Button |Shaw

EHelp Config

EPrint Config

EDownload setting

HSound

EZoom Config

Hsearch

Hshare

HAutoFlip i
Thumbnail Button |Enable

Hsingle Page

HLanguage

i. Home Button

You can add a home buttonn to help reader to click and go to your website directly:

. EHorﬁ_é .EL_.ltt.(_ﬂn ) )
_Home Button Visible Show
Page LRL hitp:/fflipbui. ..
Cpen Windaw [Blank

ii. About Button

Add About button to show the author, contact, book, company info:

[ ElAbookButbon |
! About Button Visible | Show
| Content a:textfon‘nat:_j

Click "..." to enter into "About & Contact" edit interface:

Copyright 2012 by flash-page-flip-maker.com
-13-



b

CIC S \v""‘ PDF to Professional Page-Flipping eBook Program
' Document for user
i.;Abnut & Contact Settings - N

i e
Flip POF Professional DemoBook - | X Clear |
Presents powerful features in the Flash digital eBook, such as sodal share, print, autoplay m——
etc. | B save &s.. |
Contact us at: alice@flipbuilder.com e
http:/fflipbuilder.com | |3 Load.. |

| © pemo

‘You can use some “tags” to format the text shown in the "About & Contact” window, such as text font, font colar,
hyperlinks and so on,
More details sbout tags please: Click Here

| e

After clicking the About button, you will view the About window by clicking the button:

\o About & Contact

Flip PDF Professional DemoBook

Presents powerful features in the Flash digital eBook, such as social share_ print,
autoplay ete.

Contact us at: alice@flipbuilder. com

httpo/flipbuilder. com

iii. Full Screen Button

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option: Full Screen Button Show

Then you can click icon E to view flipbook in Full Screen, click icon E or "Esc"

button to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):
Full Screen Without Toal.. | Yes

iv. Help Config

BHelpConfig B
Help Buthon |Shaw

Help Content File {-type.png =]

Help Window Width 1400

_ Help Window Height 1450
Show Help At First Shaw

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you
can define Help Content manually by inserting "Help Content File (image or SWF)", also
enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the
book to center->No", you can set "Show Help At First->Show" to display the Help Panel with
the Book as below:
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Muskal poge Mpajang beals with P18y

Help: .;1
it -Chech O ddovn ey rooee s, o "

Drag Mt pegr rorsnr o
Liad Sauid mived B pagei

You can also click the button to view the same Help page in pop-up window.

v. Print Config

Print Enable |Yes
Print Wartermark File | BES s Ealgl)

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

& Pmnt '

=) Print A1 Pages
_ Print Current Page

. Print Range
Example; 2 58-26

= Print

4

You can also click "Print Watermark File->..." button to choose image or SWF file from your
computer as watermark on printed out pages.

vi. Download Setting

EIDewnload setting. .
Download Enable Yeg .
[ Dowrload LRL ADFDema.pdf!

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
"http://www.flash-page-flip-maker.com//flip-pdf/example/files/download/FlipPDFDemo.pd
f" or relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded
the PDF to the same path).
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Then readers can click the icon n to download your uploaded PDF file directly.

vii. Sound
ElSound
Enable Sound |Enable E
[ Sound File m_]
Sound Loops L

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =]" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

viii. Zoom Config

BzoomConfg |
. Zoominensble  lYes
Zoom Scale |5

Foom In

n' - {.

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by

the zoom in tool like this: m ﬂ You can also set "Scroll

with mouse->Yes" to scroll zoom in page while moving mouse.

ix. Search
| SearchButon  Tshaw
_ Search Highlight Color | JoxFFFFa0

Least search characters |3

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon

, you will see a popup box to input search words, then click Enter or "Search" button,
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x. Share

kel
.. MHshareButton |
Social Share Buttonr  |Show

You can share via emails, or just through Facebook, Twitter, Google, etc..

a. Share Button

If you want readers to share via Email, you can enable "Share" feature as below shows:

HShareButton |

. ShareButton  |Show

_ Email Subject  |Rear my fi...
Email Body i{link}

When the viewers click the share button E, they will enter into the Email interface with

the link of your flipbook in the Email body.

b. Social Share

If you want your flipbook viewers to send the link to their friends or clients via Facebook,
Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your
flipbook for readers to send out your flipbook link immediately:

| Social Shere Button _[Show

The readers just need to click the "Social Share" button ﬁ, then the below window will pop

up for them to choose share channel:
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xi. Auto Flip

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

AR e
e =T
e e R
_ PlayCount -1

Auto fip when startup [Yes

xii. Thumbnail Button

_Thumbnai Button _ [Enable
Show Thumbnail Button E(set "Enable") to view page thumbnails of your book, or you can
disable it to hide the button.
xiii. Single Page
. . éi-nujle- 'F‘-age |Enable i

If your book contains landscape pages, or the page content is different to read for the font is too

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon n to

view pages one after another, then click "Double Page" icon m to back to the normal book

reading mode.

xiv. Language

. ElLanguage i iEr;gli.sh. -
Language EnglishjChlnf_':_'J
Switchahle Yes
You can set language for showing tools or tips in your created flipbook, click "..." to enter into

"Language Settings" interface. You can choose two or more language to use, just check

"Switchable" option, then users can click "Switch Language" button l.iito choose their

prefer language for tips (more language setting details you can view in below Language
Setting part):
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Please select a language below...

English

French

(3) Tool Bar on Top (only in Float template)

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":
| Tool Bar on top [True
(4) Add Icons Settings

If you want to add some other kinds of buttons which the program doesn't provide, you can click
"Add Icons Settings->..." to enter into "Icons Settings" interface to add new icons on tool bar:

Aild Toona Sattngs
! lzons Sattings &
| Canfig icons for toolbar
Moo woete G wovepen |
53 |
Add Teon |
[con Fie
Source Fle:  Cf\iwers\AdeimaivatoriDesking ey foder maga: M_ -qp'\- | |
Button Info
Caphon: GaTo Page &
fcon Button Acton
|
o G0 0 page Open 8 bk Cal Javasorpt funcion
PageIndex: & |
-
el | I
=i

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More
details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".)

(5) Button Icons
Define settings for the icons of the buttons:
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| EButton Tcons =
!_ ey Cloxfeef

| IconsFile(SWF Only) |

i. Icon Color

| ToxFFFF =]
7?7 Q il

Icon Color

ii. Icon File

Select the Tool Bar Button to replace with your own icon.

 Tcons File(SWF Only) [Ci\Users.. |

More details please view here:

http://www.flash-page-flip-maker.com//support/how-to-replace-icons-on-flash-toolbar.htm

3. Flash Display Settings

EIFiash Display Settings
... Retain the book to center [Yes
CEFent
Initial Show | Nepe
... Show Correr Flip Effect  |False
. HBackground Config e
_ FlashWindow Color | [0x8fa0ab
. Page Background Color | [10ucffHF
HBook Proportions |
EHBook Margins

BPageshadow |
Hide Book Frame Bar |MNo

_ RihtToleft ~  INo
. HardCover Mo oo
_Flipping Tme 0.6

BPagetumber |
HMinime Style

(1) Retain the book to center

| Retain the book to center [Yes

i |

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for

embedding special background image, such as advertisement or company log.

(2) Pages per thickness (only in Neat template)
To create more real life like ebook, you can set Pages per thickness, which means how many

pages to show a distinguishable thickness. The smaller value set, the thicker your book. If the

value is smaller than 0, or larger than the total page number of your book, it won't show any

thickness. And on the book edge, you will see different page number tips for you to click and go

to that page directly:
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(3) Font
e |
e el R
_Font Color | LIOxFFAFFF
_|Tahoma

Change fonts of toolbar buttons, flash windows even bookmarks or search result panel.

(4) Initial Show (set in Float/ Spread templates)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails": LLinital show [ Thumbnis 7]

Then you will get flipbook shown with below initial interface:

g1t Thumbnais www.FlipBuilder.com Pages:

% PDF to Flash Page Flip

= Convert PDF to ebook with page = Many templates to choose
flip flash

Unadorned Classical Style

Free Import
Flexible Backgrounds Float

Set Page Range, Page Quality

Stylish & Fresh Neat Mode
Set unique watermarks on the
More Area Usable Spread
pages
Newly designed templates
Import the links, bookmarks, text

of original PDF;
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(5) Background Config

i. Background Color:

HlBackaround Config

BlBackground Color |
Gradient Colar A | JoxFFEFPr
Gradient Colar B | M0x000000
Gradient Anale |50

e Gradient Color A

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors.

ii. Background Image (set in Classical and Spread templates):

Click the icon " =" to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

iii. Background Image (set in Float template):

Eleacinyoud e
| DuielmceFs  EFroye
Emage powiton Sele bo
IrerioageFle Spregn. |
Scale 1o fit

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right.
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(6) Flash Window Color

This color will be applied on all flash windows, such as the book window, "Help" window,
"Print" window and so on.

(7) Page Background Color

.....Page Background Color

When load pages, or if the page number of your PDF file is odd, then the page (the last page)
will show with the "Page Background Color".

(8) Book Proportions

ElBook Propor bons
Page Width | 1052
Page Heght 1500

[ Width—={

Height

=]

Please note that the values are not fixed in pixels or inches, they represent a ratio of "Page
Width: Page Height", and the book size will be adjusted with your Explorer Window Size.
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(9) Book Margins

i. Book Margin (set in Classical Template):

—Margin

z Margin

"Book Margin" refers to the distance between the book and the toolbar.

ii. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

HlPage Shadow .
page shadow
. Right page Shadow
Page Shadow Opacity |
Lefe page Shadow

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(11) Hide Book Frame Bar

| Hide Book Frame Bar |'fes |

If don’t want to show the book frame bar, choose “Yes” in this option.

(12) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:
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Rightt To Laft i

Hext Page:

(13) Hard Cover

If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover |fes

(14) Flipping time
Flipping Time 0.6

Sets page flipping time in seconds according to your needs. (Recommended value is 0.6)

(15) Page Number

If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)".
For example, the first 3 pages are Table of Content pages with Roman page numbers, and
set Arabic page numbers from page 4, then you will get page number box like below:

| BPagetumber [ |
| StartPage Number Roman) |0 ‘
| Start Page Number (Arabic) |3
|Front Cover Page:

Pages:
i'."-he Fourth and Fifth Pages: |

Paces:
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(16) Minimize Style

If you want to present Page-flipping eBook pages directly without showing toolbar, especially

when you want to embed eBook into a small area in existing web pages, then you can use this

"Minimize Style".

The Minimize Style will trigger when the Width or Height of the Flash Container is less than the

defined value. You can also always show the page-flipping eBook in Minimize Style with adding a

parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true .

ElMinime Style. ol
. Use Minime Style e TS
L e O

- Pt . e v £

Click to view in fullscreen

4. Flash Control Settings

ElFlash Control Settings

. SecurtySettings  [NoSecurity
Google Analytics ID

(1). Security Settings

[ Security Settings Single Pase |

If you want to protect your flash books with passwords, you can click "...

"Flash Security Config" interface:

Haote:
Srgle Passvword option mesns thal users need e padsvard 1o wew the flash book

Exclude Front Pages oplion is ko set a page nusber, all latinr pages can't be:
vewed vethout inputtng passherd.

Security Type
1t Secwrity

L"\‘ & Tge Passwond: 123458

Protect Fage Range
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Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All
Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4
algorithm to protect eBook pages, the eBook content pages will show nothing without
permission.)

(2). Links

FLip PDF PrO

... Mouse over calor
Link alpha 0.2

.. OpenWindow  Blenk
Enable after zoomingin  |Enable

Creats your professional fipping book with PDF files

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting
"Enable after Zooming in->Enable".

(3). Google Analytics
G;:uﬁgle Analytics ID

In the HTML output format, you can add statistics by using google analytics. You can get
more information about Google Analytics ID from http://www.google.com/analytics/ .

Besides, Export Theme

If you want to save the current template settings as your own style template for later uses,
you can click "File->Export current settings as Theme" button to storing all current template
settings, include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added
to the templates selecting interface.

Download more themes from Flash-Flipping-Book now:
http://www.flash-page-flip-maker.com//templates-themes/index.html .
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ﬂ Apply Change
After setting template and language, click icon to apply the settings.

IV. Edit Pages

Use PDF to Flash Flipping Book Pro to edit imported pages directly, no matter you want to add

E.-_ Edit Pages |

|
link, video, sound or image file. Click "Edit Pages" button | & I to enter into page

edit interface:

k

Page Editing: 2

Open Flip book, drag page corner
to turn pages with realistic flipping sound.

1. Add Link

Click the icon and then draw a link box on the area you want to add link, then define

properties in below panel:
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Link Properties

O Down @ Up @ Move

= Over ® out
over Colo: I Over Alpha:

Down Color: M Down Alpha:

Naorrmal Color: Normal Alpha: ® Go topage ® Openalnk ® Call Javascript functon
® Open Fash Window @ Play Audio ® Photo Slideshow
URL:

Link Target: Bank

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. For example, you can show a pop-up light box while readers clicking some
image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make
sure the parameter you set in "Function" can be called in from HTML page.

Example: Check "Call Javascript function" as action type, then input Function as
"testLightBox("Hello, this is a test"):

® Down © Up ™ Move

® Over ® Qut

Go to page @™ Openalink @ Call Javascript function

Function:

And then make sure the Javascript wrote into the index.html page as below image shows (the
same as you set in "Link Function"):
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<head>
<title>PDF-BenU brochure 2010-100dpi</title>
<meta http-equiv="Content-Type™ content="text/html; charset=utf-8" />
<meta name="Keywords™ content="" /3>
<meta name="Description” content="" />
<meta name="Generator™ content="[Flip EDF version 3.0] at http://flipbuilder.com/™ />

<style type="text/c3a"™ media="screen™>
htel, bedy | height:;l00%:; }
body { margin:0; padding:0:; overflow:auto: text-align:center;
background-color; #££f£fif; )
#flashContent | displayinone; ]|
Lfatyler

<script type="text/Javascript">

function tEﬁtLightBng|strFranlash}{
e

glert{acrFromFlash) ;
}

</script>

2. Add Movie

Click icon and then draw a box like below on the page you want to insert FLV movie:

Then you can select and edit the movie in below panel (define video player skin color, play and

stop movie actions, etc.):

Movie Properties

Select FLV Movie

Player Skin Color:

Play Movie: When dlick Play button

When diick Play button
Stop Movie: il
When enter the page

When leave the page

- B
m e TSN B
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3. Add Image

Click the icon E to draw image box and then select image (.jpg, .png, .bmp), set Action

Options (the same as Link Action Options):

Image Properties X Action Options

Action Options © Down @ Up @ Move

® Over ® out

® Gotopage © Openalink @ Cal Javascript function
® Open Flash Window @ Py Audio @ Photo Skdeshow

URL:

Link Targat: Blank

v

4. Add Sound

Click the icon - to draw sound box and then select sound file, set other options:

Sound Properties

5. Add Flash

Click icon . to insert SWF flash into your defined area of flipbook page:

e h B8
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6. Add Button

Click icon to draw an area for inserting your image or SWF button file with calling actions.
The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash
Window". The before three actions are the same with the actions in "Add Link", the "Open Flash
Window" can help you to play SWF Flash or FLV Video in the pop-up window:

Button Properties Open Window Action Properties

Select an Icon(SWWF, Image) Window Type: Open the window to play a video

Action: Options Window Content: select The File
[ Action Options

Plaa:
Window Caption:
= ] 2 -» [ ) /i
HON I W o Window Width: Window Height:
® Over ® Out

® Gotopage ™ Openaiink @ Call Javascript function

© Open Fash Window

B ED

7. Add You Tube Video

[ You |
Click the icon and then draw a box on the page to insert You Tube video into pages directly.

You just need to define the video ID directly. For example the video link is:
http://www.youtube.com/watch?v=xKA6W!IqjB7c, then the video ID is " xKA6WIqjB7c".

YouTube Video Properties

Video ID:

Video Parameters:

Play Movie: When click Play button

= y When dick Py button
Stop Movie:

When enter the page

When leave the page
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8. Add Printable Area
If you want readers can click on some area of your book to print the area directly, such as
coupons which can be used to buy your presented goods, you can add a "Printable Area" on

-
pages by clicking the icon , and then draw the area on the pages, set title and description:

Link Properties

Calor: B over Apha: B

C — & Border Color: Border Width: B
Title:

Description:

9. Copy and Paste
If you want to add same links, images, videos, audios to different pages, you don't have to repeat
the "Link/Image/Video/Audio added" operations once and once again, just select the link object,

click the copy button and then go to the other page to click the paste button ﬂdirectly.

10. Apply All
If you want to use the same link, video, audio, image or button on all pages (or all odd, even
pages, or your customized pages), you can select the object and then click the Apply All button

--.
, then define the apply page range in pop-up window like below:

Page Ranges

™ AllPages @™ Odd Pages ™ Even Pages

® Custom range:

After adding links, flash, movie or sounds, you can click the icon to save the settings and

back to the template setting interface.
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V. Language Options Interface

Click "Option->Flash Language" or ".." button beside Language setting part, you will enter
into the Language Settings interface as below shows:

” Language S“e‘ttmgs lﬂh
You can edit current language file or add a new language to display your page-fiipping eBook, two or more languages can be
used at the same time. Readers then can dick "Change Language” button to view the eBook in their prefer language.
The first checked language on the top of the Languages™ list will be taken as the default language to show your fiip book. You
u can also define a language to the published flipping-book by specifying with the address like:
http: /fwww.somedomain. com/mybook. himl?pagelndex=4&lang =Japanese
Lauangues I
English B saveas... ),;,I Load... J |;/ Edit |
Chinese Language Settings
[ Arabic
[ French Label | Labeled -
First Button First |
i:' German MNext Page Button Mext Page
[] Greek Last Button Last -
Previous Page Button Previous Page
[ Hebrew Download Button Download
[] ttalian Print Button Print
Search Button Search
[] Japanese Book Mark Button Book Mark
[ Portugues Help Button Help
Enable FullScreen Button Enable Fullscreen
Disable FullScreen Button Disable FullScreen
Sound On Button Sound On
Sound Off Button Sound Off
Share Button share
Sodal Share Button Social Share
Zoom In Button Zoom In
| Zoom Out Button Zoom Out
| Auto Flip Button Auto Flip =
+ X & ¥
oK

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you 10 different languages for you to use:
English, Chinese, Arabic, French, German, Greek, Hebrew, Italian, Japanese and Portuguese.

You can also add other language for your own uses:

1. Click the button % and define name for the new language:

'w New Language 'ﬁ1

New Language |
Daee:; Frendch

Copy From:; --Eng'hsb -

o | | cnce

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save and Edit Next":
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Kext Page Button

Mext Page

Last Button hast I Edti Language Item
Previus Pags Buttan Previgus pg ————————
Doweroad ::lm Dowriad || BEtLEmRage Strig |
Prink, Button Print

Saarch Button Seareh Label i FirstBution
Book Mark Button Boak Mark ~
Help Button Help |abeled:  Presdére|
Enable FulSoreen Button Enabla Fulls

Disabls Fullsersen Button Disainle Futd

| Bnemd Oim Busthne,

Somed O B

| sovesncedtrent | [ ox

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

MNext Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button
Disable Fullscreen Button

o imid P Bakbam

Labled

Premigre

Page suivante
Derniére

FPage précedente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Désactiver FullScreen
| o Smamd

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33 Load..,
Load language file saving before for current using:

After setting template and language, click

apply the settings.

f’ Apply Change
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VI. Output Interface

U Cutput Option

utput |

Cutput type

i @ = =] i
/3 @ =html = D *zip

HTML Title: demo

DBuLn to CO

|| Make it automatically play the fiipbook in CO

g:g@?! 7 =exe i', ) *.app

[7] Also Make Mobile Version  Make output page-fipping eBook works on iPad, iPhone and Android mobile devices

Path

Qutput Folder: .C:'d_isers'v'-;.dministra.mrkDesktop'lﬁ.ipboék l Browse... ” Open l
File Mame: index html

Options

| 4 Advanced

=0 0:1:0,6; PLDS  DYD-ROM DH-16D35 VD15

[ Cancel | I LConvert

Output types:

1. HTML

3 @ =i

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo g,s ﬁdvancedJ

Set Keywords, Description or even Script in the below interface:
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Ig| Advanced Settings ﬁ
HTML Advanced Settings |
HTML Meta Settings
Titfe: demo

Keywords:  pdf, flipbook, page-fipping, ebook, online, website, flash, background, music

Description:  [his page-fipping Book shows you the stunning flash effect on PDF pages, a

Add Scripts
‘fou can put some tracking
code such as Google
Analytics here,
Need dosed <saipt>tag!
[oona
2.ZIP
Bi @z
]

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon: &

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

files

Ik‘?ﬁu:ler‘rm.htrnl

bunk.swf

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:
—
ﬁﬁ
demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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U Advanced Settings e
Exe Advanced Settings I
Exe Window Info
Cagption: dema
I:M‘TE v | | pefadt |
Window Size Opbon
Mawmized Custom Size
9 Full Soreen
L S Cancel
4. APP

If you want to make executable application to run on Mac devices, you can output as
"* app" format.

5. Mobile Version
: i;f_.ﬂ.lso Maine MDEiie Version |

You can even output Mobile Version while choosing HTML or ZIP format at the same time.
After creating mobile versions, you just need to output all files online (including HTML, SWF,

"files" and "mobile" folders), then you can visit the flipbook page through your mobile
browser.

6. Burn to CD

[¥]Burn to €D

CD Writer |0:1:0,G: PLDS  DVD-ROM DH-16D55 VD15 »

Disc title: |Page-Flipping eBook

After choosing output type, then check the option "Burn to CD", set "CD Writer", define
"Disc title".

How to make created eBooks available for others online, more details this support page:
http://flash-page-flip-maker.com//support/how-can-i-share-my-created-ebook-online.htm .

At last click lbonuerty button to output flipbook in your defined type.
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VIl. Upload Online

E ==

After designing your book style, you can click "Upload Online" button ! to

upload your book onto Flash-Flipping-Book website server directly. Upload the books to
Flash-page-flip-maker.com/ server, just need 4 steps: Register, Receive login username and
password, login your account, upload your books.

Wos— e W W

|

|

Upload the books to FlipBuider.com server, just need |

- following steps: |

1. Register

|

|

|

2. Receive login username and passward;
3. Login your account;
= 4, Upload your books.

Mare details about hosting books onto FlipBuilder. com, dick Here

‘fou must login befare you can upload. ..

() If you have an account @ Apply for a new account (Registration) |

2 Register

Remember the password Auto login |

‘ | Login Cancel

1. Register
Click Register button in the program to build your account in Flash-Flipping-Book. Enter into
http://panel.flash-page-flip-maker.com//chargeback/registered.php to create ID, as below

interface shows:

Create an ID Create an ID
Choose an ID and user name.

Please fil out the folawing nformation and to view our Terms of Service!

Input your Email, User Name (which will be a part of the final book online URL, like
http://online.flash-page-flip-maker.com//Flash-Flipping-Book/demebook/index.html,
"Flash-Flipping-Book" is your User Name, and "demobook" is the Book name.), read Terms of
Service, if agree, then click "Subscribe" button to enter into PayPal interface, login and prepare to
Copyright 2012 by flash-page-flip-maker.com
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pay for the service from the secondary month, because first month free, and you can stop the
service at any time you want.

2. Receive Login Username and Password

Once you confirm and process the final payment on the PayPal web site, you will receive your
Payment Receipt, Registration Information, Rental Information in your email box which you set
while building your own account. And PayPal will charge your account periodically, and all of the
paying info will be sent to your email box instantly.

3. Login Account

Back to PDF to Flash Flipping Book Pro program, then select "If you have an account", input
your Email and Password to login.

4. Upload Your Book
After login your account, you will access into "Config the book" window to upload your just
created book:

I8l Config the book ™ e
1 F = 3 =
Book settings |

HTML Meta Settings
Tite: POF to Fip Back
Keywords: page-fipping, ebook, publish, online, thinkness, sound, image, design, template, theme

Description: convert pdf to page-flipping ebooks to publish online easily, with background image, =ound, book thickness effect added

Add Scripts

<saript type="text/fjavascript™> You can put some tracking
f.rput your javascript code belowe code such as Google
< fscript> Analytics here.

Meed dosed <script>tag!

[7] also Make Mohile Version  Make outnut page-flinping eBook works on Pad, iPhone and Android mobile devices

) Override an existed book

|’ Demo Book of Online %
Book name: 2012-Febrary * a
‘ é | http-fonfine flipbuilder.com/fiipbulder/demoBookiindex.himl ||
The book name will be a part of the final online URL, so you'd best make the fipbuider is the User Name  demoBook is the Book Name
names unigue and different.
=

You can set HTML metadata, like Title, Keywords, Description and Scripts. Check "Also Make

Mobile Version" or not, set Book Name, which will be a part of the final book online URL, like
http://online.flash-page-flip-maker.com//flippingbook/demebook/index.html, "PDF to flash

flipping book" is your User Name, and "demo book" is the Book name.

Click "OK" at last, your book will be published right away. You can use the Book URL to share
with others online, or through social share websites, or copy the Embed Code to insert into
web pages, etc.
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More FAQs about Upload Service:
http://panel.flash-page-flip-maker.com//userLoad/faq.php

VIIl. Batch Convert Interface

| Batch Comvert

| £ Add PDF Documents

Mo addFies || Acd Eoder erove B Clearal et T e [
| name Path
+Flip Printer E:Wseful Documents\PDFs'Flip Printer. pdf
+Flip POF E:\Useful Documents|POFs Fiip PDF. pdf
~Flip Word E:Wseful Documents\PDFs'Flip Word.pdf
+Flip PPT E:\Useful Documents\PDFs'Flip PPT.pdf
) settings

Output Settings | PDF Settings |

Output type

-
9 @ *hml @“ @ *zp !’&E}! O exe ‘L © *amp

[¥] Also Make Mobile Version  Make output page-fiipping eBook works on iPad, iPhone and Android mobile devices
Path

Output Folder: C:Wsers\Administrator\Desktop'fipbook

File Mame: {PDF FileName} « html
Flip Printer
Options
HTML Title: My FiipBook - ‘% Advanced
My FlipBaok

[F1Merge All POF Files to One FlipBook

3 Convert to Flash

* Convert to Flash
|

1. Add PDF Documents
s AddFiles |

Click this icon to add PDF files from computer;

s AddEoder| . .
i Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

% Remaove aﬂ Clear all -@ Move Lip % Move Down

2. Settings

(1). Output Settings

i. Choose Output Type

Output type
s

i';%' @ *htm = @ *.zip r_’&j% @) *.exe i‘_ ©) *.app

[] Alsa Make Mobile Version  Make output page-flipping eBock works on iPad, iPhone and Android mobile devices

ii. Choose Output Path
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You can also define output name pattern with FileName, Title, Subject and so on:

File Name: v

{PDF Title}
{PDF Subject}

,j-iDF .ﬁ.uﬂﬁnri
POF FileMame]

And after defining the File Name, you can preview the result example below:

File Mame: {PDF FileName} Flipping Bock =

Flip POF Flipping Book

iii. Define Output Option
Options
Caption;  {FDF FileMame} -
Flip POF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:

‘J Advanced Settings ﬁ .J Advanced Scttings @
WTML Advanced Settrgs | B | [ e Advanced Setings |
HTML Meta S21ungs Exe Window Info
i o demo Caption:
Epvwords:  pdf, flobook, page-fipong, ebook, oniing, website, Sash, baduy ound, music
r ! !
Desoripton: | Mhis page-fippng elsck shows you the shurning flash effect on POF pages, & s =N |
Add Sopt Window Size Dpbon
Tiou Can pul some frading Manamarad Cystom Size
mmuﬁwﬁe
ytics have,
Need dosed <sariptatag! B Bl Sareen
Lo ] [Lomn | o] (o

iv. Merge All PDF Files to One Flip Book

[#]iMerge All POF Files to One FlipBook:

(2). PDF Settings

i. Page Range
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The Page Ranges to Import
71 All pages

@ e 2-5 Example: 1,9-21,30

You can convert "All pages" or just "Custom range";

ii. Watermark
Watermark
_ﬁ‘ -~ Place a custom text or image
W Watermark{Stamp) to the file{s)
_ e

Click "Set Watermark" icon to enter into "Watermark" interface:

Cption - m
YWatermark
] Applying Watermark
Watermark Name Type o
v &
[C] A Text -Fre Text e
] A Text - COMPLETED Text ]
[] A Text - DRaFT Text "
W [T] A Text - FOR PUBLIC RELEASE Text 1
il [T A Text - INFORMATION OMLY Text =
77 A Text - NOT FOR PUBLIC RELEASE Text
[T A Text - HOT APPROVED Teak A 3¢ 1
M Tl A Text - Company(Tie) Text 5
[T1 A Text - LOGO (left-tog) Teut 3
[F] A Text - LOGO (Right-Top) Text
[] A Text - LOGO (Left-Bottom) Text -~
] A Text - LOGO (Right-Bottom) Text
|:_E A Text - Dynamic - (tte) Text
i 7] = image - LOGD image - |
| Lo | [ concer |

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

Medium guality medium file size
Low quality small file size
Lower quality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options

Wi ook ¢ your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;
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¥/ Import inks If your PDF file has links, check this to enable in flipbook;

i ok soech Check this option to enable search functionality in created flipbook.

. _ Convert to Flash

At last, click

icon to batch convert listed files together.

IX. Use PDF to Flash Flipping Book Pro in Command Line

You can also use PDF to Flash Flipping Book Pro in Command Line.

PDF to Flash Flipping Book Professional Command Line Usage:

PTCMD.exe [Options]
-f<PDF File>
-o<output folder>
-t[html|zip | exe]
-n<OutputFileName>
-c<caption>

-s<Flash settings>

-r<page range>.

-g<import quality>

-R<GS|SWF|LIB>

The source PDF file.

Specify the folder for the output files.
Output type. Default is html.

Specify the name for the output file.
Caption for HTML or EXE.

Value format is:<Template name>#[<Theme name> |
<txt_settingfile path>].

<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.

<txt_settingfile path> is the file that you export

with "Save the template settings" function

The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,0r All.(Default: All)

Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

Render engine options. (Default: GS, Ghostscript render
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engine)
-b<Y|N> Import bookmark yes or no. (Default: Y)
-I<Y|N> Import links yes or no. (Default: Y).
-S<Y|N> Enable searchable or not.(Default: Y, enable searchable)
-k<html key words> Set the keywords for html output file.
-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.
-w<window size> Specify the size of exe window.

Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:

PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r'1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -o0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:
PTCMD  -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -tzip  -c"Title"
-s"Float#Blank" -r"All" -5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

Py s WNR
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License Agreements

All copyrights to PDF to Flash Flipping Book Pro (the Software) are exclusively owned by
Flash-page-flip-maker.com/. For more information, visit our website at
www.flash-page-flip-maker.com/ .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by FLASH-FLIPPING-BOOK Solution.
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Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.

How to Order

Order Online
(http://www.flash-page-flip-maker.com//pdf-to-flash-flipping-book-pro/index.html) or Order

Toll Free 1-877-353-7297 (When you order toll free just give the operator the product
number of the product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.

Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.
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100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at support@flash-page-flip-maker.com/ .

Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here:
http://www.flash-page-flip-maker.com//support/list-pdf-to-flash-flipping-book-pro

2. Learn tutorial about PDF to Flash Flipping Book Pro

We publish a video tutorial which shows you the easy procedure of dealing with PDF to Flash
Flipping Book Pro, you can view this video to quickly handle the stunning tool:
http://www.flash-page-flip-maker.com//demo/pdf-to-flash-flipping-book-pro.swf

3. Get lost license code

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.
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4. Contact Us

If you have other questions or requirements, contact us directly through our support Email:
support@flash-page-flip-maker.com/, we will respond you ASAP.
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